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  «Портфолио жасаған кезде Auto play  бағдарламасын қолдану» 

тақырыбында оқыту семинары. 

Қазіргі уақытта ақпараттық-коммуникациялық технологияларды білім 

беру үдерісіне жылдам енгізу контексінде электрондық портфолионың 

болуы,оқытушының АКТ құзыреттілігінің негізгі көрсеткіштерінің бірі 

болып табылады. 

Электрондық портфолионның басты мақсаты - кәсіптік мансаптық 

бағалаудың практикалық қызметінің нәтижесі ретінде нақты жобаларды іске 

асыру, фестивальдар мен сайыстарға қатысқан, өткізілген педагог 

зерттеулері, оқу-әдістемелік материалдары және т.д. 

Кәдімгі айырмашылығы, электронды портфолиосымен қамтамасыз 

етеді: 

- материалдың үлкен көлемін жүйелі түрде өзгертіп, жаңартып отыру; 

- оперативті материалға қол жеткізу; 

- көптеген аудиторияға арналған демонстрациялық мүмкіндіктері; 

- графикті, аудио- және видеоматериалдарды және т.б. пайдалану үшін 

интерактивтілік пен визуалды қамтамасыз ету. 

Қазіргі заманғы бағдарламалық қамтамасыз ету, әртүрлі форматта 

сандық материалдарды жүйелеу үшін, нақты бағдарламаларды бөлуге 

мүмкіндік береді. Барлық мүмкін бағдарламалар портфолионы құру үшін 

ұсынылуы мүмкін. 

Осындай бағдарламалардың біреуі - AutoPlay Menu Builder. Қарапайым 

және интуитивті интерфейспен AutoPlay Menu Builder тіпті дербес 

компьютердің жаңа пайдаланушысына күрделі навигация жүйесі, мәзірлер 

мен авториндермен қысқа уақыт ішінде бағдарламалық жасақтама өнімді 

құруға мүмкіндік береді. 

Алдыңғы оқу жылында бірнеше мұғалімдер аттестациядан өтті, 

аттестациялау үшін қажетті шарт электронды портфолио құру болды. 

 Портфолио жасау процесі менің портфолиум мысалында көрсетіледі. 

 

 

Электрондық портфельді құру кезеңдері: 



Портфолио құру кезінде, бірнеше негізгі кезеңдер бар. 

1. Портфолио құрылымын дамыту. 

2. Портфолиоматериалдарын каталогтар бойынша іріктеу және жүйелендіру. 

3. Портфолионықұру. 

4. Портфолионыдискігесақтау.        

   

Портфолиоқұрылымы. 

Анықтамаға сүйене отырып, портфолионы қамту мүмкін: мұғалім 

туралы ақпарат, оның әдістемелік әзірлемелеріне сілтемелер, сондай-ақ 

кәсіби қызметтің жетістігін растайтын әртүрлі құжаттарға сілтемелер. 

Қарапайым біріккен портфолионың құрылымын суреттеп, схемалық 

түрде сипаттап көрейік. 

Оқытушы туралы мәліметтер, мысалы, білім, жұмыс тәжірибесі, санат 

және т.б. қарапайым мәтіндік блоктар немесе жеке құжаттардың 

сканерленген суреттері болуы мүмкін, олар жеке портфолио бетінде 

орналастырылуы мүмкін: «Ресми құжаттар». 

Әдістемелік дамуы әртүрлі форматтағы дайын файлдар болып 

табылады. Бұл жағдайда осы файлдарды портфолиомен байланыстыру үшін 

сіз «Әдістемелік дамуы» портфолиосынан портфолио файлдар мен 

бағдарламаларды тікелей ашуға мүмкіндік беретін гиперсілтеме жүйесін 

пайдалана аласыз. 

Портфолиолардың тағы бір жарқын компоненті - дипломдардың 

сканерленген суреттерінің фотоальбомдары және т.б. 

 

  Менің портфолио құрылымым келесідей: 

 

 

 

Тақырып
Ресмиқұжаттар Жеке құжаттар, дипломдаржәнет.б. 



беті Ғылыми-әдістемелікжұмыс Өзін-

өзідамытудыңәдістемеліктақырыбыж

әнет.б. 

Оқу-әдістемелікжұмыс Педагогикалыққызметтіңөзіндікталд

ауы 

Оқу-әдістемеліккешені Пәндер бойынша УМК 

Ашықсабақтар Ашықсабақ материалы 

Тәрбиежұмысы Тәрбиежұмысыныңжоспарлары 

Педагогикалыққызметтіңн

әтижелері 

Пәндердегіпедагогикалыққызметтіңм

атериалдары 

Оқудантыссабақтардыөткіз

у 

Сабақтантысашықсабақтардыңматер

иалдары 

Портфолиоматериалдарыніріктеужәнежүйелендіру 

Материалдардыіріктеужәнежүйелендірупортфолионықұрудағынегізгіқа

дамболыптабылады. 

Барлықпортфолдағытабыст

артікелейорналастырылған

материалдардыңсапасынаб

айланысты. 

Еңалдымен, 

ұсынылғанфайлдардыңәрқа

йсысыныңмазмұны мен 

әдістемелікқұндылығын 

қамтамасыз ету. 

Тағы бір маңызды 

мәселе - сандық 

фотосуреттерді таңдау. 

Төмен сапалы бейнелер,іскерлік  стилімен сәйкес келмеуі, бүкіл 

портфолиодағы визуалды тартымдылыққа жиі әсер етеді. 

Осы кезеңде портфолио үшін таңдалған барлық материалдар 

қалталарға жүйеленген және болашақ портфолионың арнайы жасалған 

қалтасына орналастырылуы керек. 

AutoPlay Menu Builder бағдарламасына кіріспе 



Жаңа жобаны құру. 

1. AutoPlay Menu Builder бағдарламасын іске қосыңыз. Мұны орындау 

үшін, іске қосу: Бастау → Бағдарламалар → AutoPlay Menu Builder... → 

AutoPlay Menu Builder... 

2. Экранда пайдалы экран пайда болса, ұсынылған кеңестермен 

танысып, терезені жабуыңызға болады. 

3. Жаңа жобаның терезесіндегі енгізу жолында түймешігін басыңыз 

және Басқаша сақтау тілқатысу терезесінде құрылған Portfolio_Family 

қалтасының жолын көрсетіңіз. Портфолды нөлден бастап жасайтындықтан, 

Бос Меню белгішесі Шаблондар өрісінде бөлектелуі керек. 

 

 

 

 

 

 

 

 

 

 

AutoPlay Menu Builder бағдарламасының интерфейсімен танысыңыз. 

Әрі қарай жұмыс істеу барысында, сіз бағдарламаны шарлауды үйренуіңіз 

керек. Құрал тақталары мен параметртерезелері көрініс мәзірі арқылы 

орнатылатынын ескеріңіз 

 

 



Терезенің негізгі элементтері. 

 

Портфолионың негізгі атауының нысанын безендіру. 

Пішін өлшемін өзгертіңіз және тақырыбын жасаңыз. 

1. Нысан инспекторы терезесінің ең төменгі жағында Сипаттар 

қойындысындағы Ені жолағына қажетті мәндерді пикселдермен жолағында, 

Биіктігі пиксельдер өрісіне енгізіңіз. Терезенің шекарасын созып немесе 

қысу арқылы пішінді өзгертуге болады. 

2. Құралдар тақтасында Стильді мәтін құралын таңдап, бос пішінде 

мәтіндік жақтауды сызыңыз. 

3. Нысандар инспекторы терезесінде, Сипаттар қойындысындағы Жазу 

өрісіне тегі, аты және әкесінің атын енгізіңіз, мысалы, Шевченко Олеся 

Анатольевна. 

4. Нысан инспекторы терезесінде, Сипаттар қойындысында, 

жасалынған жапсырманың өлшемін және құрылымын, градиент 

толтырысының түсін өзгертіңіз. Басқа параметрлерді қалағандай қарап және 

өзгертіңіз. 



5. Жұмыстың орнын, атқаратын лауазымын және портфелінің 

құрылымын көрсететін тағы бір ұқсас жазба орналастырыңыз. 

6. Жазылған жазбаларды орталыққа теңестіріп, жоғарғы жағынапішінің 

орналастырыңыз. 

Кескінді кірістіру 

1. Құралдар тақтасында кескін құралын таңдап, пішінде фотосурет 

аймағына сурет салыңыз. 

2. Орнатылған фотосурет толығымен жасалған контейнерге 

орналастыру үшін, Нысан инспекторы терезесінде Сипаттар қойындысында 

параметрлерді орнатыңыз. 

3. Инспектор терезесінде, Сипаттар қойындысындағы Сурет өрісінде 

осы батырманы басыңыз. 

Пайда болған терезеде 4. Сурет редакторы, Load бастырмасын 

басыңыз, (ол қалта Ресми құжаттар болуы тиіс) фотосуретке өтіңіз, және OK 

түймешігін басыңыз. 

5. Бастапқы фотосуреттің арақатынасын қалпына келтіру үшін кескін 

өлшемінқосыңыз. 

Шарлау түймелерін кірістіру 

AutoPlay Menu Builder бағдарламасының негізгі артықшылықтарының бірі - 

портфолионың барлық беттерінде қарапайым және икемді навигация жасау 

мүмкіндігі. Шарлау түймелері - шарлаудың бір әдісі. 

1. Шарлау түймелерін жасау үшін, Галерея 

параметрлері терезесін орнату қажет. AutoPlay Menu 

Builder терезесінде пайда болмаса, келесі әрекеттерді 

орындаңыз: View → Gallery. Әрбір үлгі түймені 

көрсетудің үш жолы бар: белсенді емес күй, 

маятниктің күйі және басылған күй. 

2. Ұсынылған түймешік үлгілерінен дизайнға сәйкес 

келетін кез келген үлгіні таңдаңыз және оны тақырып 

пішініне сүйреңіз. 

3. Инспектор терезесінде, Сипаттар 

қойындысындағы Жазу өрісінде түймешіктің атын 

енгізіңіз: Ресми құжаттар. 



4. Портфолио сол стильде орындалуы керек, әр беттегі шарлау түймелері бір 

үлгіге де орындалуы керек. Әрбір жаңа түймені қайта жасау мүмкін болмаса, 

аяқталған түймені аралық сақтағышқа көшіріңіз: Өңдеу → Қосымша үш 

көшірмені көшіріңіз және қойыңыз: Өңдеу → Қою. 

5. Түймешіктерді пішінде дұрыс сәйкестендіру үшін оларды торға қолмен 

тура апарыңыз немесе параметрлер терезесін пайдалануға болады. 

Түзету. Егер ол көрсетілмесе, орындаңыз: Көру → Көлбеу тақтасын. 

6. Фотосуреттің үстіңгі және астыңғы жағына екі түймені қойыңыз. 

7. «Сәйкестендіру параметрлері» терезесінде (көлденеңінен ортаға дәл 

келтіріңіз) түймешігін басып, (Бірдей жерде бірдей түймесін басыңыз). 

Түймелер  бірдей қашықтықта орналасуы керек. 

Нәтижесінде  Портфолионың негізгі беті пайда болады. 

 

 

 

 

 

 

 

 

 

Портфолионы сақтау және қайта ашу. 

Портфолионы жасау, өте ұзақ уақытты алады, сондықтан аралық 

нәтижелерді дұрыс сақтауды үйрену өте маңызды және оларды қайта ашуға 

мүмкіндік болуы тиіс. 

Аралық нәтижелерді сақтау. 

1. Аралық сақтау жүргізіледі: файлды сақтау немесе көлденең құралдар 

тақтасындағы, түймесін басыңыз. Жұмыс барысында жұмысыңызды көбірек 

сақтап отырыңыз, бұл мәліметтердің жоғалуын алдын алады. 



2. AutoPlay Menu Builder терезесін жабыңыз. 

Портфолионы қайта ашу 

1. AutoPlay Menu Builder бағдарламасын іске қосыңыз. Мұны орындау 

үшін, іске қосу: Бастау → Бағдарламалар → AutoPlay Menu Builder. ... → 

AutoPlay Menu Builder. 

2. Жаңа жобаның терезесін жабыңыз. 

3. Орындаңыз: Файл → Ашу. 

4. Ашылған терезеде Портфолио қалтасына жолды көрсетіңіз және 

autorun.apm файлын таңдаңыз. Ашу түймешігін басыңыз. 

 

 

 

 

 

 

 

 

 

 

Портфолиодағы фондық дизайн және тақырыптық жолақ 

Осы бөлімде сипатталған барлық параметрлер портфелдің барлық беттерінде 

көруге болады. Сондықтан әр түрлі бетке әртүрлі фондарды қолданғыңыз 

келсе, кескін құрамдасын фон ретінде таңдап, оны фонға қойыңыз. 

1. Тақырып формасының бос жерін басыңыз. 

2. Сипаттар қойындысындағы Объектінің инспекторы терезесінде Жазу 

өрісіне мәтінді енгізіңіз: Портфолио Шевченко О.Л. Пішіннің тақырып 

жолында осы жапсырманың қалай пайда болғанына назар аударыңыз. 

3. Нысан инспекторы терезесінде, Сипаттар қойындысында Градиент немесе 

Түсқағазды фон ретінде таңдаңыз. Градиент таңдасаңыз, градиенттің 



бастапқы және соңғы түстерін, сондай-ақ Градиент стилін көрсету қажет. 

Тұсқағазды фон ретінде таңдасаңыз, суретті Кескін өрісі арқылы басып, 

түймені басуыңыз керек. Фондық және негізгі мазмұны керісінше болуы 

керек екенін ескеріңіз, барлық мәтінді оқу керек. 

Жаңа беттерді кірістіру. Беттер арасындағы сілтемелерді орнату. 

Жаңа бетті қосу. 

1. Аяқтаңыз: → Қосу. 

2. Пайда болатын Жаңа бетінде: Ресми құжаттар мен OK түймешігін 

басыңыз. 

 

 

 

 

3.  Сол сияқты басқа бір бет жасаңыз: Ғылыми-әдістемелік жұмыс. Барлық 

жасалған беттер бет шарлау жолағындағы қойындылар ретінде көрсетілетінін 

ескеріңіз. Болашақта пішімдеу үшін беттер осы қойындылар арқылы 

жылжиды. 

 

Навигацияны орнату. 

Беттерді толтырмас бұрын, сіз навигация туралы ойлау керексіз, яғни 

бастапқы беттен, келесі беттерге және артқа қарай, портфолионың барлық 

беттері бойынша алдыға-артқа жүруіңізді қамтамасыз етуіңіз керек. 

1. Басты бетке өтіп, түймешіктердің бірін аралық сақтағышқа көшіріңіз. 

Мұны істеу үшін кез-келген түймені таңдап, орындаңыз: Edit → Copy. 

2. Профиль бетін басып, орындаңыз: Edit → Paste  

3. Беттің төменгі жағында орны түймесін және оның орнына сол 

батырмаларының көлденен етіп өлшемін азайту. 

4. Нысан инспекторы түймешігі үшін жаңа атауды теріңіз: Мәзір. 



5. Түйменің тағы екі көшірмесін жасаңыз. Мұны орындау үшін Мәзір 

батырмасын бөлектеп, орындаңыз: Edit → Copy. Содан кейін Өңдеу → Қою 

түймешігін екі рет басыңыз. 

6. Суретке сәйкес көлденен атап,  батырмасынсәйкестендіру, Мәзір,Артқа. 

 

 

7. Мәзір батырмасынын ортасын бөлектеңіз. 

8. Назар аударыңыз! Нысан инспекторы терезесінде 

Әрекеттер қойындысын нұқыңыз және Әрекет түрі 

өрісінде мынаны таңдаңыз: Бетке өту 

9. Беттің аты өрісінде мынаны таңдаңыз: Басты бет. 

10. Артқа түймешігін басыңыз. Нысан инспекторы 

терезесіндегі Меню түймешігі сияқты Әрекеттер 

қойындысын нұқыңыз және Әрекет түрі өрісінде мынаны таңдаңыз: Бетке 

өту. 

11. Бет аты өрісінде мынаны таңдаңыз: Алдыңғы бет. 

12. Сондай-ақ, Келесі батырмасы үшін келесі әрекетті орнатыңыз: Келесі бет. 

Барлық беттерге көшіру батырмалары. 

1. Ресми құжаттар бетінде барлық түймелерді тінтуірдің айналасына 

айналдырып, орындаңыз: Өңдеу → Көшіру. 

2. Бетке өту, Ғылыми-әдістемелік жұмыс және орындаңыз: Өңдеу → Қою. 

Бастапқы бетіне навигацияны орнату. 



1. Мұқаба бетіне өтіп, Ресми құжаттар түймешігін басыңыз. 

2. Нысан инспекторы терезесінде Әрекеттер қойындысын нұқыңыз және 

Әрекет түрі өрісінде мынаны таңдаңыз: Бетке өту. 

3. Бет атының өрісінде мынаны таңдаңыз: Ресми құжаттар. 

4. Сондай-ақ, басқа беттерге көшуді жасаңыз. 

Назар аударыңыз! Жұмыс кітабын басу түймешесі сканерленген құжаттар 

мен фотосуреттердің альбомын ашады. Осы түйменің параметрлері кейінірек 

талқыланады. 

Навигация параметрлерін тексеру және аяқтау. 

1. Көлденең құралдар тақтасында Тест түймешігін басыңыз. 

2. «Жетістіктер» батырмасын қоспағанда барлық түймелерді тексеріңіз. Егер 

қате кету анықталса, Exit («Шығу») түймесін басып, түзетулер жасай 

отырып, белсенді терезені жабыңыз. 

3. Навигациялық қателер толығымен жойылғанша жобаны тексеріңіз. 

 

Қорытынды бақылау және жобаны жазу. 

Мұғалімнің портфолиі, әдетте, үй компьютерінде жеке қарауға арналмаған, 

бірақ арнайы дайындалған аудиторияда әріптестердің қатысуымен 

демонстрация және қорғау үшін. Бұл жағдайда жобаны әртүрлі 

компьютерлерде алдын ала тексеру және тестілеу өте маңызды. Мұндай 

тестілеу кезінде пайда болған ең көп кездесетін қателіктер: 

гиперсілтемелердің бұзылуы, суреттерді дұрыс жүктемеуі, қаріптерді өзгерту 

және т.б. 

Мұндай қателерді болдырмаудың бір бөлігі, AutoPlay Menu Builder 

бағдарламасында қарастырылған жобаның сыртқы тестілеуі көмектеседі. 

1. Жобаның барлық гиперсілтемелерінің басты қалта ішіндегі файлдарға 

ауысуын қамтамасыз ететіндігін тексеріңіз. 

2. Орындау: Файл → Сыртқы тексеру. 

 



3. Барлық секіру батырмалары мен жобалар еренсілтемелері арқылы өтіңіз. 

Қателерді анықтаған кезде, терезені өңдеуге оралып, оны түзетіңіз. Тестілеу 

қателер толығымен жойылмайынша жүргізілуі керек. 

4. AutoPlay Menu Builder терезесін жабыңыз және жобаны әзірлеу ортасы 

болмаса тексеріңіз. Ол үшін Portfolio_Family қалтасын ашыңыз және 

орындалатын autorun.exe файлын екі рет нұқыңыз. Портфолио көру 

режимінде дереу ашылуы тиіс. 

 

Назар аударыңыз! 

1. Кез-келген сандық медиаға жазғанда, барлық Portfolio_Family қалтасының 

мазмұнын көшіру керек. 

2. Егер сіз суретден дискілерді жаза білетін болсаңыз, онда сіз мына 

әрекеттерді орындай аласыз: Құралдар → ISO кескінін жасау ... Бұл жағдайда 

авторанмен диск жасалады. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Біздің педагогикалық ұжымымыздың кішкене бөлігі. 



 

 

 

 

 

 

 

 

 

 

Менің айтарым. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Максим Сергеевичтің «Auto Play» бағдарламасы туралы шағын сөзі. 

 

 

 

 

 

 

 

 

 

 

 

Auto Playбағдарламасымен танысу 
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